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Einführung 
 
Die Programme Cobalt Xenon und Argon enthalten professionelle Renderfunktionalitäten um 3D Modelle photorealistisch 
darzustellen. 
Zusätzlich wurden die Vellum Environments Fotostudio Umgebungen entwickelt die mit den Programmen Cobalt Xenon und 
Argon eingesetzt werden können. 
Die Vellum Environments sind vordefinierte voll ausgestattete Fotostudioumgebungen mit denen Sie Ihre Modelle in wenigen 
Minuten professionell belichten und rendern können. Es gibt drei Studiotypen und fünf  Studiogrössen. 
Die Photostudioumgebungen geben Ihnen eine Grundausstattung für Ihre Arbeit um rasch professionelle Darstellungen zu 
erstellen. 
Ein gutes Rendering benötigt keine weiteren Einstellungen und Anpassungen. 
Die Vellum Environments Photostudioumgebungen bestehen aus grossen Oberflächen wie sie in echten Photostudios  auch 
vorkommen. Die Beleuchtungen sind voreingestellt und können schnell angepasst werden um unterschiedliche Renderstyle zu 
erhalten. 
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Kurzeinführung 
1. Öffnen Sie eine bestehende Zeichnung. 
2. Blenden Sie nur das Modell / Objekte ein das gerendert werden soll. 
3. Zoomen Sie das Modell bildschirmfüllend. 
4. Wählen Sie einen Studio Typ und importieren Sie diesen in die Modelldatei. 
5. Blenden Sie einen Studio Layer ein welcher in etwa 20 mal grösser ist als das Model. 
6. Legen Sie die Ansicht und die Begrenzung der Darstellung fest. 
7. Rendern Sie die Darstellung. 
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Die Rendering Umgebungen 
 
Universal Studio 
Das Universal Studio eignet sich für die meisten Modelle. Es 
kann mit vielen unterschiedlichen  Renderstylen farblich 
getönt werden. Dieses Studio eignet sich für Umgebungen 
mit weitem Hintergrund. 
 

 
 
Chrome Studio 
Materialien wie Chrom benötigen reflektierenden 
Hintergrund der die reale Umgebung oder die Photostudio 
Umgebung nachahmt. Das Chrome Studio wurde ähnlich 
aufgebaut wie ein Photostudio welches  für glänzende 
metallische Objekte eingesetzt würde. 

 
 
Infinite Studio 

 

Der Boden des Infinite Studio enthält  eine spezielle 
‘Schatten Aufnehmer’ Textur die beim Rendern zwar 
unsichtbar ist aber den Modellen ermöglicht einen Schatten 
auf den Boden zu werfen. Beim Rendern wird nur das Modell 
im Raum mit seinen Schatten, der Hintergrundfarbe oder 
Bildes dargestellt. Das resultierende Rendering sieht aus als 
ob es einen unendlichen Hintergrund hätte. 
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Modell für das Rendering vorbereiten 
Objekt Auflösung einstellen 
 
Bei Oberflächen und Volumenkörpern muss immer die beste Auflösung eingestellt werden um die bestmöglichen Resultate für 
das Rendering zu erhalten. Am schnellsten ändern Sie die Auflösung indem Sie alle Objekte wählen die gerendert werden 
sollen und anschliessend das Objekt Bearbeiten Fenster öffnen. Unter der Registerkarte Attribute geben Sie für die 
Auflösung  Superfine ein. 
 
Durch das heraufsetzen der Auflösung wird mehr Zeit und Rechenleistung für die Bildschirmneuberechnung benötigt. Wenn 
Sie mit komplexen Bauteilen arbeiten oder wenn Ihr Rechner keine leistungsfähige Grafikkarte besitzt müssen Sie 
gegebenenfalls Kompromisse bei der Auflösung eingehen damit Sie noch flüssig arbeiten können. 
 

 

Die Auflösung kann auch mit dem Befehl >Bearbeiten > 
Auflösung ändern  oder indem Sie mit der rechten 
Maustaste auf das Objekt klicken und die Option Auflösung 
wählen. Um das manuelle Umstellen der Auflösung zu 
vermeiden sollten Sie diese auf Superfine voreinstellen bevor 
Sie die Render Studio importieren. 
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Farben zuweisen 
Die Farbe eines Bauteils kann geändert werden indem Sie das 
Bauteil wählen und anschliessend mit dem Befehl >Linie 
>Farbe >Mehr das Fenster mit der Farbenpalette öffnen und 
eine Farbe auswählen. Am einfachsten können Sie die 
Bauteile wählen wenn die Perspektive ausgeschaltet ist.  
 

 
 
Materialien zuweisen 
Um realistischere Darstellungen der Bauteile zu erreichen 
können den Bauteilen Materialien zugewiesen werden. Ein 
Material enthält Informationen zur Farbe, zur 
Oberflächenstruktur, zum Reflektionsverhalten, zur 
Transparenz, zur Orientierung und zum Größenverhältnis 
bezüglich der Oberfläche. Um dem Bauteil ein Material 
zuzuweisen wählen Sie >Fenster >Render Bibliothek. 
Die Render Bibliothek enthält eine große Auswahl an 
vordefinierten Materialien. 
Wählen Sie im Render Bibliothek Fenster unten links die 
Option Materials aus. Wählen Sie dann eine Materialgruppe 
wie z.B. die Materialgruppe Metall. 
 

 

 
Verwenden Sie die horizontale Scrollleiste um weitere Materialien anzuzeigen oder vergrößern Sie das Fenster. Klicken Sie 
auf ein Material, halten Sie die Maustaste gedrückt und ziehen Sie das Material auf das Bauteil welchem Sie das Material 
zuweisen möchten. Wenn Sie dabei den Mauszeiger über das Bauteil ziehen wird es rot markiert und zeigt damit an dass das 
Material diesem Bauteil zugewiesen wird sobald Sie die Maustaste loslassen.  
Am einfachsten können Sie die Bauteile wählen wenn die Perspektive ausgeschaltet ist. 
Nachdem Sie dem Bauteil ein Material zugewiesen haben wird im Objekte Bearbeiten Fenster eine zusätzliche Registerkarte 
Material angezeigt. 
 
Beachten Sie dass Sie zuerst ein Material zuweisen müssen bevor die Registerkarte im Objekt Bearbeiten Fenster angezeigt 
wird. 
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Materialien bearbeiten 
Wählen Sie ein Bauteil oder eine Oberfläche welchem vorgängig ein Material 
zugewiesen wurde. 
Öffnen Sie anschliessend das Fenster Objekte Bearbeiten mit dem Befehl  
>Fenster >Objekte bearbeiten oder indem Sie die Tasten Ctrl + I  (Win) bzw. 
Command + I (Mac) drücken, oder auf die Maustaste rechts klicken (Win). 
 
Klicken Sie auf die Registerkarte Material. Es erscheinen unter anderem vier 
Schieberegler. Grau dargestellten Schieberegler können für das zugewiesene 
Material nicht geändert werden. 
 

 
 
Die Einstellungen der Kontrollkästchen sind oft von Bedeutung. 
 
Schatten werfen aktivieren 
Voreinstellung aktiv. Deaktivieren Sie dieses Kontrollkästchen wenn Licht durch das Bauteil durchscheinen soll wie z.B. bei  
der Glaslinse einer Taschenlampe.  
 
Schatten aufnehmen aktivieren 
Voreinstellung aktiv. Deaktivieren Sie dieses Kontrollkästchen wenn Sie keine Schatten auf Ihrem Bauteil sehen möchten. 
 
Rückseite rendern 
Voreinstellung nicht aktiv. Aktivieren Sie dieses Kontrollkästchen wenn Sie Objekte rendern die Transparent (wie z.B. Glass) 
sind. 
 
Ist Hintergrund Objekt 
Voreinstellung nicht aktiv. Aktivieren Sie dieses Kontrollkästchen für Objekte die beim Rendern nicht sichtbar sein sollen aber 
z.B. reflektieren sollen. Dies verringert die Rechenzeit für das Rendering. 
 
Objekt Farbe verwenden 
Voreinstellung aktiv. Deaktivieren Sie dieses Kontrollkästchen wenn die Fortgeschrittenen Render Material Einstellungen die 
aktuelle Objektfarbe überschreiben sollen. 
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Fortgeschrittene Render Material Einstellungen 
Wählen sie die Option Fortgeschritten im Objekte Bearbeiten Fenster um das Fenster Render Material Einstellungen zu 
öffnen. 
 

 
 

 
 
Im oberen linken Bereich des Fensters Render Material Einstellungen finden Sie ein Pulldown Menü mit fünf 
Schattiertypen. Jeder Schattiertyp beeinflusst unterschiedliche Eigenschaften des Materials. 
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Die fünf Schattierarten 
Eine Materialtextur kann durch fünf Schattierarten (Shader Typ) dargestellt werden. Die Color , Displacement , Reflectance 
und Transparency Schattierarten sind nicht voneinander abhängig und können wie unten gezeigt verwendet werden um eine 
Materialtextur abzubilden. Der Texture Space Schattierart kann aber die anderen vier Schattierarten beeinflussen. 
 
Color 
Dieser Schattierart kann eine bestimmte Farbe ein Muster oder ein Bild 
sein und kann auch Holzmaserungen oder Kachelmuster enthalten. 
 
Displacement 
Diese Schattierart kann 3D Oberflächentexturen oder „Beulen“ abbilden. 
Sie kann „regular“ „organic“ oder „Image“ basierend sein. 
Ein komplexes Detail kann durch ein Bild auf einen Körper oder eine 
Oberfläche appliziert werden um ein schnelles Rendering und kleinere 
Modelldateien zu erhalten. 
 
Reflectance 
Diese Schattierart beeinflusst die Reflektierung des Lichtes auf einer 
Oberfläche. Die Reflektion kann von matt bis spiegelnd und von Glas bis 
Chrom variieren. 
 
Transparency 
Diese Schattierart beeinflusst die Transparenz eines Objekts. Diese kann 
gleichmässig oder als Muster appliziert werden. Die Durchlässigkeit des 
Lichts durch den Körper wird aber durch das Reflectance Attribut 
beeinflusst.  
 
Texture Space 
Diese Schattierart bestimmt die Abbildung der Textur auf einem Objekt. 
Die Textur kann gebogen, skaliert und dem Objekt angepasst werden. 
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Anwenden der Schattierart (Shader Typ) 

 
Im obigen Beispiel wurde an den Bauteilen eines oder alle Attribute der Rendereinstellungen geändert. Im folgenden finden 
Sie einige der Änderungen aufgelistet. 
 
Boden 
Color  Plain   R 255 G 0 B 0 
Displacement Wrapped Tread Plate Scale 1 
Reflectance Plastic 
Transparency Plain 
Texture Space Arbitrary Plane  Scale 1 
 
Lampenkörper 
Color  Plain   R 255 G 0 B 0 
Displacement Wrapped Knurl  Scale 1 
Reflectance Mirror   Mirror factor 0.05 
Transparency Plain 
Texture Space Cylindrical  Scale around axis 0.02 

Scale along axis 0.2 
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Taschenlampenglas (Linse) * 
Color  Plain   R 230 G 230 B 230 
Displacement Rough 
Reflectance Glass   Specular factor 2.70 

Transmission factor 0.96 
Mirror factor 0.10 
Rough factor 0.001 
Refraction 1.8 

Transparency Plain 
Texture Space Arbitrary Plane  Scale 1 
 
Reflektor 
Color  Plain   R 16 G 16 B 16 
Displacement Rough   Scale 1 
Reflectance Conductor 
Transparency Plain 
Texture Space Arbitrary Plane  Scale 1 
 
Ein Aus Schalter * 
Color  Plain 
Displacement Wrapped bump map File:Skin.lwi 
Reflectance Translucent Plastic 
Transparency Plain 
Texture Space Auto Axis  Scale 1 
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* Im Fenster Objekt Bearbeiten im Register Materials sind sowohl bei der Linse als auch bei beim Boden die Option  
“Enable Shadows Cast” nicht gewählt. Dadurch geht das Licht eines Lichtobjekts durch das Modell hindurch.  Beide Objekte 
haben die Option Double Sided Facets gewählt was bewirkt dass sich das transparente Material wie ein echtes Material 
verhält. – wie z.B. die Linse einer Taschenlampe. 
 
Sie sollten die Möglichkeiten der Advanced Render Einstellungen näher anzuschauen und auszutesten. Mit einer form- und 
strukturgebenden Textur kann ein Material einfach und schnell dargestellt werden. Ansonsten würde dies sehr viel Zeit und 
Aufwand beim modellieren oder zum anbringen von Abbildern (image mapping) in Anspruch nehmen. 
Die folgenden Abbildungen zeigen ein Objekt welches mit unterschiedlichen Materialien und Einstellungen bearbeitet wurde. 
Von oben rechts: Voreinstellung Phong Schattierart und folgende mit unterschiedlichen Schattierart Texturen. 
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Abbilder 
Anbringen von Abbildern (Wrapped Image) 
 

          
Ein Bild aus einer externen Quelle kann auf eine Model appliziert werden indem das Modell im Objekte Bearbeiten Fenster 
unter den Fortgeschrittenen Einstellungen bearbeitet wird. Im folgenden Beispiel wird ein Bild passend auf ein Modell 
projiziert aufgetragen, ausgerichtet und skaliert 
 
Erstellen und speichern Sie ein Bild welches etwa die doppelte Grösse/Auflösung der Grösse des endgültigen Renderings hat. 
Das Bild muss als  JPG, TIFF oder BMP Datei gespeichert werden. Gehen Sie dann ins Programmverzeichnis (z.B. Cobalt 
>Programme >PhotoRender >Textures) und kopieren Sie das Bild in den Ordner Textures. 

 
 
Wählen Sie >Fenster >Render Bibliothek und im eingeblendeten Fenster unten links Materials. 

 
 
Bewegen Sie den Mauskursor auf das <None> (kein Material Verbotsignal) klicken und ziehen Sie mit der Maus das Material 
auf das Modell und lassen Sie die Mautaste los wenn das Model markiert wird. Dem Modell wurde nun ein leeres Material 
zugewiesen. 
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Während das Objekt noch immer markiert ist wählen Sie >Fenster >Objekte Bearbeiten (oder klicken Sie auf die rechte 
Maustaste und wählen Sie Objekte Bearbeiten). Wählen Sie die Registerkarte Material und dort die Schaltfläche 
Fortgeschritten. Dadurch wird ein neues Fenster für fortgeschrittene Render Materialeinstellungen eingeblendet. 
 
 
 

 
 
• Aus dem Schattieren Pulldown Menü wählen Sie Color. 
 
• Wählen Sie aus der Schattier Modus Liste die Option wrapped Image. 
 
• Unter Attribute wählen Sie file name. 
 
• Wählen Sie im Attribute Wert Pulldown Menü das von Ihnen eingefügte Bild aus (welches Sie zuvor in den Ordner  
   Textures kopiert haben). 
 
• Wählen Sie Aktualisieren um die Vorschau mit dem Bild anzuzeigen das Sie gewählt haben. Es ist möglich dass das Bild  
   noch falsch skaliert ist oder dass es sich noch an der falschen Position befindet. 
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• Unter Schattieren wählen Sie Texture Space 
 

 
 
• In der Auswahlliste Schattier Modus wählen Sie arbitrary plane. 
 

 
 
• Unter Attribute wählen Sie origin. Die Bezeichnung origin ist der Punkt im Raum an welchem das Bild mit der linken 
unteren Ecken platziert werden soll. Sie können die Werte eingeben oder Sie können mit dem Mauszeiger einen Punkt 
anwählen. Die Koordinaten des gewählten Punktes werden automatisch in die Felder eintragen. 
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• Im Auswahlfeld Attribute wählen Sie normal vector. Der normal vector ist die Ebene des projezierten Bildes. Geben Sie 
Werte in die Eingabefelder ein oder klicken Sie auf einen Punkt im Modellbereich welcher die Vorderseite des Bildes 
bestimmt und anschliessend auf einen Punkt welcher dahinter und rechtwinklig zur Bild Ebene liegt. 
  

 
 
• In der Auswahl Attribute wählen Sie up. Definieren Sie die up Richtung für Ihr Bild indem Sie 1 in das Datenfeld eingeben 
(1 entspricht üblicherweise dem Z Datenfeld) oder klicken Sie an einen Punkt welcher sich unten am Bild befindet und 
anschliessend einen Punkt oberhalb des zuvor gewählten Punktes. 
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• In der Auswahl Attribute wählen Sie scale und in der Auswahl Attribute Wert geben Sie die maximale Breite Ihres 
Modells ein welche vom Bild bedeckt wird. Der Wert muss in Inch eingegeben werden auch wenn in den Voreinstellungen 
eine andere Masseinheit eingestellt ist (1 inch = 25.4mm). 
 

 
 
• In der Auswahl Attribute wählen Sie aspect ratio und in der Auswahl Attribute Wert geben Sie die maximale Höhe Ihres 
Modells welches vom Bild bedeckt wird, geteilt durch die maximale Breite des Modells welches vom Bild bedeckt wird (das 
bedeutet dass Sie die Höhe geteilt durch die Breite H/B eingeben müssen worauf das Programm den Wert automatisch 
errechnet). 
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Texturen ausrichten (Texture Space) 
Mit Texture Space kontrollieren Sie die Position und die Grösse der 
Textur auf einem Modell. 
 
Applizierte Texturen (Wrapped textures) können auf einem Modell 
auf unterschiedliche Arten dargestellt werden. 
 
Folgende Abbildungen zeigen die Einstellmöglichkeiten. 
 

 

 
 

  
Arbitrary plane 
Projezieren entlang einer 
bestimmter Achse 
 

 
Auto axis 
Projezieren entlang XY&Z 

 
Spherical 
Kugelförmig appliziert 

  
Cylindrical 
Entlang einer Achse appliziert 

 
X axis 
Projezieen in X Achse 

 

 
Y axis 
Projezieren in Y Achse 

  
Z axis  
Projezieren in Z Achse 

 

 

 

     22 



Ashlar Vellum Environments                                                                                                                                               Copyright Arnold CAD GmbH 
  

                                                                                                                                                                                                                                  _

Reflektion bestimmen 
Mit Reflectance kontrollieren und bestimmen Sie wie stark eine 
Oberfläche Licht reflektiert und ob sie matt oder glänzend 
erscheint. 
 
Die Effekte die durch das ändern der Hauptattribute 
hervorgerufen werden sehen Sie auf der folgenden Abbildung. 
  

 
 
Ambient Factor Bestimmt wie stark das Umgebungslicht die Reflektion beeinflusst. Dies beeinflusst das Licht in den 

schattierten Bereichen. 
Die obigen Einstellungen sind: low 0.0, medium 0.5, high 1.0. 
 

Diffuse Factor  Bestimmt wie viel direktes Licht reflektiert wird. 
Die obigen Einstellungen sind: low 0.0, medium 0.5, high 1.0. 
 

Specular Factor  Bestimmt die Intensität der beleuchteten Objekte. 
Die obigen Einstellungen sind: low 0.0, medium 0.5, high 1.0. 
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Benutzerdefinierter Abbilder 
Abbilder (Decals) werden zum schnellen anbringen eines Aufdrucks, eines Belages, eines Logos etc. auf Ihrem Modell 
verwendet. Im folgenden wird das anbringen eines einfarbigen Benutzerdefinierten Schriftzuges beschrieben. 
 

 
 
Zuerst wird ein schwarzweisses, invertiertes Bild benötigt das als Schablone dienen soll. 
 
Dieses Bild sollte als JPG, TIFF, BMP oder LWI Datei gespeichert werden. Kopieren Sie das Bild in den Order Texturen der 
sich im Programmordner (z.B. Programme >Cobalt >PhotoRender >Textures), befindet. 
 
Wählen Sie Fenster >Render Bibliothek und dort die Auswahl Decals im Pull Down Menü unten links. 
 

 
 
 
Bewegen Sie den Cursor über ein Abbild (Decal), drücken und ziehen Sie 
das Abbild mit der Maus auf das Modell und lassen die Maustaste los 
wenn das Modell hervorgehoben dargestellt wird. Die Begrenzungen des 
Abbildes werden nun angezeigt und Sie können das Abbild auf der 
Oberfläche an die gewünschte Stelle schieben. Die Begrenzungslinien 
passen sich der Oberfläche des Modells an. 
. 
  
Ein nicht symmetrisches Abbild (wie z.B. die Zahl zwei) erleichtert Ihnen die Orientierung des applizierten Abbildes. 
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Um die Orientierung des Abbildes (Decals) zu prüfen können Sie einen 
Ausschnitt des Bildschirms rendern. Drücken Sie dazu die Crtl (Win) oder 
Option (Mac) Taste und wählen Sie einen Render Befehl im Menü >Rendern. 
Ziehen Sie dann mit der Maus ein Fenster für den gewünschten 
Randerausschnitt auf. 
 
Markieren Sie das Abbild mit dem Auswahl Werkzeug und öffnen Sie 
anschliessen das Objekt Bearbeiten Fenster mit >Fenster >Objekte 
bearbeiten. Die Abmessungen, das Vorlagebild und andere Attribute des 
Abbildes können in diesem Dialogfenster bearbeitet werden. 
Um das Abbild zu drehen geben Sie einen Wert in das entsprechende 
Eingabefeld Winkel. Positive Werte drehen das Abbild im Urzeigersinn und 
negative Werte im Gegenurzeigersinn. 
 

 

 

 
In der Auswahl Schablone wählen Sie dann Ihre eigene Bilddatei aus der Liste aus. Die Grösse und die Abmessungen der 
Abbilder bleiben wie voreingestellt 1 Zoll (25.4mm) unabhängig vom Masstab oder der eingestellten Masseinheit. Ändern Sie 
die Breite und die Höhe im Objekte Bearbeiten Fenster bis das Abbild die richtige Grösse hat. Wählen Sie anschliessend  
Anwenden um die Eingaben zu übernehmen. 
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Wählen Sie nun die Registerkarte Attribute, um weitere 
Attribute anzuzeigen. In der Auswahl  Farbe wählen Sie 
diejenige Farbe aus die Sie für das Abbild (Decal) in Ihrem 
Rendering verwenden wollen. 
 

 
 
Sie können jede beliebige RGB-Farbe wählen wenn Sie in 
der Auswahl Farbe die Option Mehr.. wählen und 
anschliessend Anwenden wählen. 

 
 
Für die Erstellung von Abbildern (Decals) gibt es unzählige weitere Methoden; die im Benutzerhandbuch beschrieben sind. 
 
 
Anmerkung: In der Version 6 und früheren Versionen von Cobalt Xenon und Argon wurden die Abbilder (Decals) bezogen 
auf den Modellraum lokal und nicht auf das Bauteil bezogen appliziert. Dadurch wurden die Abbilder beim verschieben des 
Bauteils nicht mit verschoben und gegebenenfalls nur teilweise oder überhaupt nicht angezeigt. 
 
Normalerweise werden Vorlagen für die Abbilder (Decals) in anderer Grafiksoftware erstellt, wie z.B. Adobe Photoshop. Es 
ist aber möglich die Vorlagen der Abbilder in Cobalt selbst herzustellen indem z.B ein Objekt in eine Datei gerendert wird und 
man dieses Bild in den Ordner Textures speichert. Der Text im vorherigen Beispiel könnte folgendermassen erstellt werden. 
Mit dem Text Tool würde man zuerst einen Text erstellen und diesen zu einem Bauteil extrudieren. Der extrudierte Text muss  
dann mit dem Werkzeug Körper entfernen von einem Block weggeschnitten werden. Wenn der Block schwarz ist kann man 
damit das negative Matrizenbild bzw. die Schablone erstellen, indem man das Bauteil mit dem ausgeschnittenen Text von oben 
betrachtet, mit dem Befehl >Rendern >In Datei rendern speichert. 
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Studio Umgebungen 
Studio Typ für das Rendering wählen 
Die meisten Renderings können mit dem Universal Studio erstellt werden. Nur wenn ein unendlicher oder unsichtbarer 
Hintergrund benötigt wird (Infinite Studio) oder wenn das Rendering sehr stark reflektierende Materialien enthält (Chrome 
Studio) sollten Sie einen anderen Studio Typ verwenden. 
 

 
 
Obiges Rendering zeigt eine Kugel mit unterschiedlichen Materialien versehen im jeweiligen Studio Typ. 
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Importieren des Studios 

 
 
Die Rendering Studio Dateien sind sehr kompakte Argon-Files, die von Argon, Xenon oder Cobalt geöffnet oder importiert 
werden können. Sie können zu einer bereits existierenden Modelldatei hinzugefügt werden, ohne dass die Datei signifikant 
grösser wird. Der einfachste Weg, einer existierenden Datei ein Modell Studios hinzuzufügen ist, das entsprechende Studio zu 
importieren mit dem Befehl >Datei >Import >Argon (Xenon oder Cobalt). Ein importiertes Studio fügt der existierenden 
Modelldatei neue Layer und Unterlayer hinzu. 
 
Nachdem das Studio importiert wurde wird es im Layer Manager als neuer Layer angezeigt.. Um den neuen Layer 
anzuzeigen wählen Sie >Fenster >Design Explorer und klicken Sie auf die Registerkarte Layer Manager. 
 

 
Layer manager 
A Arbeitslayer  Ein Bleistift zeigt an dass neue Geomtrie auf diesen Layer geschrieben wird. 
B Sichtbar  Durch klicken auf das Auge wird der Layer jeweils ein- oder ausgeblendet. 
C Unterlayer  Durch klicken auf den Pfeil + werden die Unterlayer ein- oder ausgeblendet. 
D Layer Name  Durch zweifaches klicken auf den Layernamen kann dieser geändert werden.  
E Layer Farbe  Durch mehrmaliges klicken werden die Farben für die Layer Geometrie geändert. 
F Layer Sperren  Durch klicken wird der Layer gesperrt bzw. wieder entsperrt. 
G Anzahl Objekte  Zeigt an wieviele Objekte sich auf dem Layer oder in der Layergruppe befinden. 
Jeder Studio Layer enthält fünf Unterlayer mit unterschiedlicher Grösse (von Mini bis Mega). Jeder dieser Ordner (Mini bis 
Mega) enthält wiederum 3 weitere Unterlayer in denen die Objekte der Rendering Studios enthalten sind. 
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Um die Studio Umgebungen auszuschalten klicken Sie am einfachsten auf das Augensymbol. Dadurch werden auch alle 
Unterlayer ausgeschaltet. 
 
Nachdem die Grösse für das Studio gewählt ist sollten die Layer für den Hintergrund und Boden (Backdrop) und die Lichter 
(Lights) eingeschaltet sowie der Test Ball Layer ausgeschaltet werden. 
 
Anmerkung: 
Wenn ein bestehendes Studio geöffnet und nicht importiert) wird, werden bei dieser Studio Datei automatisch drei zusätzliche 
Layer erstellt (Construction, Dimension und Layer 1). Diese drei Layer sollten Sie vor dem speichern der Studio Datei wieder 
löschen da sie ansonsten unnötige Layer zu jeder Modelldatei hinzufügen zu welcher die Studio Datei später importiert wird. 
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Studio Layer Komponenten 
 
Backdrop Enthält die Boden- und die Wandflächen, Die Bodengrösse wird in Millimeter oder Meter angegeben. 
 
Lights Punkt-, Spot- und Parallel Lichtquellen (nicht das Umgebungslicht). Lichtquellen erscheinen immer als 

Drahtgittermodell im Modellbereich. 
 
Test Ball Eine Kugel die eine schnelle Rendervorschau der Szene und der Textur in mm ermöglicht. 
 
 
Universal Studios: mini, small, medium und big 

 
Die Universal Studios sind so gemacht dass damit ein zykloramisches Photostudio simuliert werden kann. Viele Aufnahme- 
und Filmstudios sind mit solchen Wänden , Bühnen und Böden ausgestattet die solch gerundete Ecken besitzen. Durch den 
gleichmässigen Übergang von einer Fläche in die andere ergeben sich keine harten Kanten, was das Beleuchten und das 
Ausgestalten einfacher macht. 
 
Die Universal Studios besitzen keine Decke da diese gewöhnlich nicht in den Renderings zu sehen ist. 
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Die meisten echten Fotostudios sind eierschalenweiss angestrichen (dies ist auch die Voreinstellung der Universal Studios). 
Allerdings ist oft ein bestimmter Bereich spezifisch gestrichen um bestimmte Stimmungen oder Umgebungen zu simulieren. 
Beim fotografieren von Autos wird zum Beispiel eine traditionelle Technik angewendet bei welcher die Studio Farbe der 
Autofarbe entspricht. 
Die Wände der Studios bestehen aus zwei Teilen die mit Hilfe der Befehle im Zeigen/Verbergen Fenster verborgen werden 
können, falls sie ungewünschte Reflektionen erzeugen. Die Wände können auch gedreht werden. 
Es gibt vier voreingestellte Lichter: 
 
Hauptlicht Beleuchtet das Modell von der Kamera her 
Fülllicht  Beleuchtet das Modell und füllt die Schatten gegenüber der Kamera. 
Hintergrundlicht Beleuchtet den Boden und die Wände hinter dem Modell. 
Unterlicht Beleuchtet das Modell von unten, wenn die Bodenoberfläche Casts Shadows ausgeschaltet ist. 
 
Alle voreingestellten Lichter können verschoben geändert gelöscht etc. werden. 
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Universal Studio: mega 

 
 
Das Universal Mega Studio simuliert ein Einkaufscenter oder eine Fabrik. Es gibt hier einen zusätzlichen ‘Grid Light’ Layer 
mit einer obenliegenen rasterförmigen Beleuchtung. Wenn Sie glatte Wände benötigen, können Sie eines der kleineren Studios  
auch vergrössern. 

 
 
 

 

     32 



Ashlar Vellum Environments                                                                                                                                               Copyright Arnold CAD GmbH 
  

                                                                                                                                                                                                                                  _

Chrome Studio: Alle Grössen 

 
Chrom und andere hochreflektierende Materialien sind sehr schwierig zu fotografierende oder zu Rendern, da sie ihre 
Umgebung reflektieren und nicht von gegen sie gerichtete Lichtquellen beleuchtet werden. 
Der Aufbau der Umgebung muss dazu dienen die reflektierende Oberfläche des Modells zu begrenzen und muss gleichzeitig 
eine geeignete Fläche für das Rendering schaffen. 
Studiofotografie von verchromten Teilen wird oft in einem weißen ‚Zelt’ erstellt, das aus aufgehängtem Stoff, Pappe oder 
Styroporstreifen besteht. Die erzeugten Spiegelungen sind feine Abstufungen von weiß mit klaren Linien an den Rändern. 
In Wirklichkeit ist es in einem „Zelt“ mit diesem Aufbau recht schwierig zu arbeiten, da ein solches Zelt alles daringliegende 
umhüllt inklusiv der Kamera und der Beleuchtung. Das Selbe Problem ergibt sich auch beim Rendern. 
Das Chrom Studio enthält nur die Wände der hinteren Hälfte des Studios. Die vordere Hälfte wird offenem Licht ausgesetzt. 
Betrachtungen und Renderings können mit einem solchen Aufbau einfacher erstellt werden. Der Hintergrund kann für die 
Reflektion anstelle der fehlenden Oberflächen eingesetzt werden. 
Chrom, draussen fotografiert, reflektiert den blauen Himmel, der oben dunkel ist und am Horizont blass verschwimmt. Der 
Boden ist dunkel am Horizont und unten heller. 
Die Chrome Studios sind so erstellt dass sie sowohl Indoor-Studio als auch Outdoor-Umgebung simulieren können. Die 
Voreinstellung ist ein mix aus Indoor-Studio mit leichtem himmelblauem Schimmer. 
Die Beleuchtung der Umgebung ist schwieriger da das Modell stark reflektiert. 
Wenn man ein nicht reflektierendes Modell rendert wird die Beleuchtung nur auf die Umgebung und die umliegenden Objekte 
angewandt. Bei reflektierenden Modellen beeinflusst die Beleuchtung hingegen die gesamte Umgebung welche wiederum auf 
das Modell einen Einfluss hat. 
Bei den Chrome Studios gibt es ein Hintergrund Licht, das den hinteren Bereich beleuchtet sowie ein Dach Licht welches 
die  Himmelsdach Oberfläche beleuchtet. Die Farbvoreinstellung für das Dach Licht ist blau um den tatsächlichen Himmel zu 
simulieren. Zudem begünstigt es auch das chromartige Aussehen. 
Die Chrom Studios sind vorne offen und im Hintergrund sieht man die Hintergrundfarbe (Background). Die Hintergrund ist 
auch vorne am Modell sichtbar weil keine Oberfläche oder Körper davor liegt. Die Farbe vom Hintergrund kann mit dem 
Befehl >PhotoRender >Edit Background geändert werden. Leicht abnehmendes Blau eignet sich für blauen Himmel und 
Schwarz, Weiss abnehmend können für Studio Umgebungen verwendet werden. 
Eine vollständige Kontrolle der Reflektion kann nur bei vollständiger Einhüllung des Modells erlangt werden, wobei dadurch  
die Beleuchtung eher schwieriger wird und unter Umständen auch wrapped image maps benötigt werden. 
 
Anmerkung: Das Mini Chrome Studio hat eine weichere Himmelsdach Oberfläche was sich für Schmuckdesign gut eignet. 
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Infinite Studio: mini & small 
 

 
 
Infinite Studio: medium 
 

 
 
Das medium Infinite Studio eignet sich besonders gut für Renderings von Möbeln und Einrichtungsgegenständen. Es hat 
Lichtquellen auf allen Seiten welche die Texturen der Modelle lebendig erscheinen lassen und den Eindruck von räumlichem 
Licht vermitteln. 
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Infinite Studio: big & mega 

 
 
Das Big und das Mega Infinite Studios besitzen zusätzliche Oberflächen um eine harte Reflektion zu vermitteln. Dies ist oft 
bei Abbildungen von Autos zu sehen welche den Eindruck einer gleichbleibenden Umgebung wie z.B. Sand oder Schnee 
vermitteln. Echte Fotografien enthalten oft reflektierende Kontraste von Oberflächen die nicht auf dem Foto zu sehen sind 
welche aber einen grossen Einfluss auf die Form und die Oberflächen des Autos haben. 
 
Die Boden Reflektion Oberfläche erzeugt einen dunklen Schleier bei abgestuften Bereichen des Modells (z.B. bei den 
Autotüren). Falls diese Reflektion nicht den gewünschten Effekt erzielt oder im Rendering störend wirkt, kann diese 
verschoben oder durch eine andere Form ersetzt werden. 
 
Boden Reflektion Oberflächen müssen oft sehr nahe am Modell liegen um den gewünschten Effekt zu erhalten. Oft so nahe 
dass die Oberfläche selbst auch im Rendering erscheint. Dies ist auch bei realer Fotografie oft der Fall und die einzige 
Möglichkeit besteht darin das resultierende Bild anschliessend zu retouchieren. Wenn der Hintergrund des Fotos gleichfarbig 
ist geht es mit einem Fotobearbeitungs Programm (wie z.B. Photoshop) sehr schnell die unerwünschten Objekte aus dem  
Renderings zu entfernen. 
 
Die Obere Reflektion Oberfläche ergibt eine haubenförmige Reflektion wie Sie auf der Windschutzscheibe und auf dem Dach 
des Fahrzeuges zu sehen ist. Die Obere Reflektion 1 und 2 wird in einer 3/4 Vorderansicht unter Umständen überflüssig oder 
erscheint selbst im Rendering. Falls dies der Fall ist verbergen Sie die Oberfläche mit dem Befehl Verbergen aus dem 
Zeigen/Verbergen Fenster. 
 
Es wird vorausgesetzt dass das Modell (in unserem Beispiel das Auto) immer am Modellmittelpunkt steht Origin X-0, Y-0 mit 
den Rädern auf bzw. leicht oberhalb Z-0 und das die Vorderansicht des Modells in die positive X Richtung zeigt. Die 
reflektierenden Oberflächen werden dann (wie gezeigt) richtig platziert. 
Das Modell, die Ansicht oder auch die Studiokomponenten können auch verschoben oder neu angeordnet werden um den 
gewünschten Effekt zu erzielen. 
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Wahl der Studio Grösse 

    
Jedes Studio hat fünf Grössen um Modelle mit unterschiedlichen Abmessungen zu Rendern.  
Name   Boden Ø  Modell Grösse  Beispiel 
 
Mega   Ø60m   3 bis 20m  Laster, Boote und Lokomotiven 
 
Big   Ø20m   1 bis 5m   Autos, Möbel und Maschinen 
 
Medium   Ø6m   200mm bis 2m  Möbel und grosse Apparate 
 
Small   Ø2m   50 bis 600mm  Haushaltgeräte und Elektronikgeräte 
 
Mini   Ø600mm  5 bis 100mm  Schmuck, Maschinenteile 
 
Jede Studio Grösse ist auf einem separaten Layer. Das Medium Studio ist als Voreinstellung sichtbar. 
Um die Studions sichtbar oder unsichtbar zu machen schalten Sie im >Design Explorer >Layer Manager die entsprechenden 
Layer ein und aus. 
Unterschiedliche Modellgrössen benötigen unterschiedliche Studio Umgebungen weil: 
 
• Es ist einfacher die Ansichten anzupassen wenn das Modell gleich gross ist wie die Studio Umgebung. 
 
• Schatten werden abhängig vom Abstand der Lichtquellen zum Modell und zum Boden unterschiedlich gerendert. 
 
• Reflektierende Objekte müssen oft sehr nahe am Modell stehen um eine Reflektion im Rendering zu bewirken. Dies ist auch  
  bei Kanten der Boden Oberfläche der Fall. 
 
• Studio Umgebungen mit gleicher Grösse wie das Modell können mit weiteren Lichtquellen erhellt werden. 
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Die Studio Umgebungen sind mit ausreichender Überlappung versehen und für beinahe alle Modelle tauglich. Falls aber mal 
ein grösseres oder kleineres Studio besser passen würde kann jedes der vorgegebenen Studio vergrössert oder verkleinert 
werden. 
Die Helligkeit der vorgegebenen Lichter wird beim schieben oder beim vergrössern/verkleinern der Studios aber nicht 
verändert. Da den Hintergrund Oberflächen keine Texturen und Materialien zugewiesen wurden, hat dies beim schieben bzw. 
vergrössern/verkleinern der Studios keinen Einfluss auf die Reflektion. 
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Rendering erstellen 
Positionierung des Modells 
 
Bei allen Studio Umgebungen ist der Boden am Nullpunkt (Origin, X-0, Y-0, Z-0) zentriert ausgerichtet und +Z zeigt nach 
oben. Die  Hintergrund Oberflächen der Studios sind beim Betrachten aus der Isometrie Ansicht (X+, Y-, Z+).so angeordnet 
dass diese gegen Sie zeigen. 
Der Nullpunkt (Origin) ist der Schnittpunkt der X, Y und Z Achsen und kann mit dem Befehl >Ansicht >Koordinatenachsen 
zeigen ein und ausgeblendet werden. 

 
Das Modell sollte in der Regel sehr nahe am Boden oder auf den Boden sowie in der Nähe des Nullpunktes platziert werden. 
Wenn Ihr Modell nicht aufrecht steht und weit vom Nullpunkt entfernt liegt sollten Sie das Modell zunächst ausrichten und an 
die richtige Position schieben bzw. den Nullpunkt verschieben bevor Sie die Studios importieren. 
 
Wenn es nicht möglich ist das Modell (oder den Nullpunkt) zu schieben weil Abhängigkeiten der Geometrie dies nicht 
zulassen können Sie das Modell als SAT Datei exportieren und in einer neuen Datei einlesen. Sie können Ihr Modell auch in 
die Zwischenablage kopieren und das Modell in einer neuen Datei ohne Abhängigkeiten und Historie einfügen. Durch das 
Löschen der Historie kann das Modell anschliessend problemlos positioniert werden.  
 
Wenn Sie Ihre Modelldatei lieber nicht verändern möchten können Sie natürlich auch die Studios an eine neue Position 
schieben oder diese im Raum drehen.  
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Ansicht bestimmen 
Um ein Rendering zu erstellen müssen drei Hauptvoreinstellungen für die Ansicht definiert sein. 
1. Betrachtungspunkt 
2. Perspektive 
3. Ansichtsausschnitt 
Die Werkzeuge in der Ansicht Palette erlauben Ihnen all die benötigten Einstellungen vorzunehmen die Sie für das Rendering 
benötigen. 
 

 
 
Betrachtungspunkt bestimmen 
• Schalten Sie die Perspektive aus. 
• Verbergen Sie alle Objekte ausser dem Modell das Sie Rendern wollen. 
• Drehen Sie am TrackBall bis das Modell optimal für das Rendering positioniert ist. 
 
Perspektive Einstellungen 
• Schalten Sie die Perspektive ein indem Sie auf das Ikon in der Ansicht Palette klicken. 

   
• Falls der voreingestellte Winkel der Perspektive (100mm) nicht passt können Sie diesen folgendermassen ändern: 
 
Wählen Sie das Auswahl Werkzeug 

   
und doppelklicken Sie anschliessen auf das Perspektive Ikon in der Ansicht Palette um das Fenster Ansicht Einstellungen zu 
öffnen. Im Eingabefeld Brennweite können Sie einen neuen Wert eingeben. 

 
Wenn Sie in einer neuen leeren Zeichnung zum Ersten mal die Ansicht mit dem TrackBall drehen wird eine neue Ansicht 
(Dynamische Ansicht) erstellt. 

 
 
Die Voreinstellung für die Dynamische Ansicht der Perspektive ist 100mm. Wenn Sie den Wert ändern wird der neue Wert 
mit der Datei gespeichert. 
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Tip: 
Um ein Modell genau vertikal ausgerichtet darzustellen 
geben Sie folgende Werte in die Vert Felder ein: 
• VertX*  0.0 
• VertY*  0.0 
• VertZ*  1.0 
Dadurch wird die Ansicht exakt vertikal ausgerichtet. 
 

 
 

 
 
Grosse Werte für die Brennweiten ergeben einen engen Betrachtungswinkel der Perspektive und kleine Werte ergeben einen 
weiten Betrachtungswinkel der Perspektive. Typische Brennweiten für die jeweiligen Studio Typen sind: 
 
Mega  1000mm bis 5000mm 
 
Big  200mm bis 2000mm 
 
Medium  100mm bis 500mm 
 
Small  50mm bis 200mm 
 
Mini  20mm bis 100mm 
 
Werte ausserhalb dieses Bereichs ergeben entweder sehr flache Ansichten (bei grossen Werten) bzw. Fischaugen Effekt (bei 
kleinen Werten). 
 
Für bestimmte Illustrationen ist keine Perspektive nötig. Wenn Sie auf das Perspektive Ikon klicken (so dass der Hintergrund 
des Ikons hell und nicht dunkel markiert ist) wird die Perspektive ausgeschaltet (unendliche Brennweite). 

 
 
Wenn ein Rendering nicht spektakulär genug erscheint hilft es oft wenn die Brennweite verkleinert bzw. ein weiterer 
Betrachtungswinkel gewählt wird. Die übertriebene Darstellung kann das Rendering interessanter erscheinen lassen. 
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Kamera Ansichten 
Als Hilfe zum Erstellen einer einer Perspektive und der Ansicht gibt es je 
fünf  fest vordefinierte Kamera Ansichten für jede Studiogrösse. 
 
Die Kamera Ansichten können über das Pull Down Menü beim TrackBall 
gewählt werden. 
 
Die Kamera Ansichten sind in etwa gleich wie die Isometrische Ansicht, 
haben aber unterschiedliche Vorgaben für die Ansichtshöhe und 
voreingestellte Perspektiven welche zur jeweiligen Studiogrösse passen. 
 

 
 
Ansichtausschnitt 
Der Ansichtsausschnitt wird durch des Zentrum des Bildes und durch die Grösse der Ansicht bestimmt. Es ist wie das 
Schieben und das Vergrössern bzw. Verkleinern eines flachen Bildes, hat aber keinen Einfluss auf die 3D Darstellung des 
Bildes(Betrachtungswinkel und Perspektive). 
 
Nachdem Betrachtungswinkel und Perspektive bestimmt sind kann der Ansichtsausschnitt mit Vergrössern bzw. Verkleinern 
(Zoomen) und durch Schieben der Ansicht bestimmt werden. 

 
Das Zoomen kann auch mit dem Mausrad bzw. das Schieben der Ansicht kann mittels der Leertaste (Space) erfolgen. 
 
In der Praxis hat sich es sich bewährt das Bild 20% bis 30% zu verkleinern (zusätzlicher leerer Randbereich) damit das 
endgültig gerenderte Bild problemlos in ein Bildbearbeitungsprogramm (wie z.B. Photoshop) übergeben werden kann. 
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Speichern der Ansicht 
Nachdem die Einstellungen vorgenommen wurden kann die aktuelle Ansicht gespeichert werden, damit man später jederzeit 
wieder zum jeweiligen Ansichtsausschnitt zurückkommen kann. Dazu gehen Sie folgendermassen vor: 
Wählen Sie den Befehl >Aktuelle Ansicht speichern aus dem TrackBall Pulldown Menü. Sie können auch mit dem Befehl 
>Ansicht >Neue Ansicht, bzw. >Ansicht >Ansicht Einstellungen Ansichten erstellen. 
 
Mehrere individuelle Ansichten (User Views) können somit gespeichert und gegebenenfalls mit dem Befehl >Ansicht 
>Ansicht löschen auch wieder gelöscht werden. 
 
Hintergrund ausrichten 
Alle Hintergründe sind so angelegt dass diese in der voreingestellten Isometrie Ansicht sichtbar sind. Falls der voreingestellte 
Ansichtswinkel nicht passt kann die Hintergrund Oberfläche entsprechend um den Nullpunkt (Origin) gedreht werden. 
Markieren Sie dazu die Oberfläche und drehen den Hintergrund mit dem Werkzeug Drehen.  
 
Wenn die Grösse des Studios nicht passt kann das ganze Studio skaliert (vergrössert/verkleinert) werden. Als Referenzpunkt 
für das skalieren sollte der Nullpunkt angegeben werden. 
 
Wenn die Form der Studio Komponente (der Oberflächen) nicht passt können diese mit den Oberflächen Werkzeugen 
bearbeitet oder auch durch andere Objekte ersetzt werden (bzw. Volumen Werkzeuge für Körper). 
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Farben und Texturen der Umgebung 
 
Die Oberflächen für den Boden und die Wände können farblich individuell verändert werden und es können auch Texturen so 
wie auf jedes andere Objekt appliziert werden. 
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Licht und Beleuchtung 
Gute Beleuchtung ist eine wichtige Komponente für das Rendering. Eine gut beleuchtete Umgebung benötigt nicht unbedingt 
viele und komplex angeordnete Lichtquellen, aber die Positionierung der Lichtquellen und die Attribute der Lichtquellen sind 
sehr wichtig. 
  
Am besten ist es mit ein paar Lichtquellen zu beginnen und weitere Lichtquellen bei Bedarf zuzufügen. Wenn viele 
Lichtquellen eingesetzt werden wird es mit der Zeit immer schwieriger vorauszusagen wie eine einzelne Lichtquelle die 
gesamte Umgebung beeinflusst. 
 
Beleuchtungsart 
Es gibt vier wichtige Beleuchtungsarten die in den Studios entsprechende Bezeichnungen haben. Hauptbeleuchtung (Key 
Light), Füllbeleuchtung (Fill Light) und Hintergrundbeleuchtung (Background Lights). Zudem gibt es das Umgebungslicht 
welches in den Programmen vorgegeben ist. Einige Studios enthalten eine Untere Beleuchtung (Under Light) die in der  
Voreinstellung ausgeschaltet ist. 
 
Hauptbeleuchtung (Key Light)  Die Hauptbeleuchtung ist in der Regel vorne links oder rechts vom 

Betrachtungspunkt des Modells positioniert. Es ist gewöhnlich das hellste Licht. 
 
Füllbeleuchtung (Fill Light)   Die Lichter der Füllbeleuchtung sind im hinteren Teil des Modells platziert und 

nach vorne leuchtend. Sie helfen die Modell zu beleuchten und verleihen den 
Schatten auch Farbe. Die Füllbeleuchtung ist in der Regel nur etwa 50% so hell 
wie die Hauptbeleuchtung. 

 
Hintergrundbeleuchtung Die Hintergrundbeleuchtung beleuchtet den Hintergrund. Eine einzelne 
(Background Lights)  Lichtquelle kann oft den Hintergrund welcher im Rendering erscheint genügend 

erhellen. Die Hintergrundbeleuchtung ist in der Regel etwa 70% oder weniger hell 
als die Hauptbeleuchtung. Natürlich können Sie den Hintergrund auch sehr hell 
beleuchten und „brennen“ lassen. 

 
Umgebungsbeleuchtung (Ambient Light) Die Umgebungsbeleuchtung ist eine nicht ausgerichtete Lichtquelle und beleuchtet 

die gesamte Umgebung. Der Vorgabewert für die Umgebungsbeleuchtung ist 0.2 
und kann von 0.0 bis 1.0 reichen. Die Umgebungsbeleuchtung hat den Effekt den 
Kontrast in einem Rendering zu reduzieren und alle Schatten und Schattierungen 
anzugleichen.  
Die Umgebungsbeleuchtung sollte im Normalfall ausgeschaltet sein (Wert 0.0). 
ausser wenn die anderen Lichtquellen nicht genügend Helligkeit ergeben, 
besonders in den dunkleren Bereichen. 

 
Untere Beleuchtung (Under Light)  Diese Beleuchtung liegt direkt unter dem Nullpunkt und zeigt vertikal nach oben.  

Diese Beleuchtung kann die untere Seite eines Modells beleuchten (falls für den 
Boden unter Attribute die Option Schatten werfen aktivieren nicht gewählt ist). 
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Licht Typ 
Es gibt drei unterschiedliche Licht Typen die in einer Modell Umgebung eingesetzt warden können. 
 
Parallellicht,  strahlt parallel und kann nicht abgeschwächt werden. Ist als Füllbeleuchtung geeignet. 
 
Spotlicht  die Standard Lichtquelle welche eine sehr gute Kontrolle ermöglicht. 
 
Punktlicht  leuchtet in alle Richtungen und verhält sich wie eine rundherum leuchtende Glühbirne. 
 

 
 
Lichtquellen können eingefügt werden indem Sie das Werkzeug aus der Palette wählen und anschliessend mit einem 
Mausklick die Position und die Richtung bestimmen (Punktlichter haben keine Richtung). 
 
Positionieren und schieben der Lichtquellen 
Lichtquellen können positioniert werden indem man mit der Maus den Punkt wählt wo die Lichtquelle zu stehen kommt. Oft 
ist es einfacher zunächst eine Hilfskonstruktion (Hilfsraster) aus Linien im 3D Raum zu erstellen um anschliessend die 
Lichtquellen exakt zu positionieren. Die Ausrichtung der Lichtquelle kann dann einfach mit einem zweiten klick auf das 
Modell, auf den Hintergrund oder auf den Nullpunkt angegeben werden. 
 
Lichtquellen haben wählbare Kontrollpunkte welche mit dem Befehl >Bearbeiten >Punkte zeigen sichtbar gemacht werden 
können. Alternativ können Sie im Fenster Objekte Bearbeiten im Register Attribute die Option Kontrollpunkte auf 
Sichtbar stellen. Die einzelnen Kontrollpunkte können individuell an neue Positionen gezogen oder verschoben werden  
Auf der folgenden Grafik sehen Sie wie die Lichtquellen im Modellraum angezeigt werden. 

 
Parallellicht (Distant)       Spotlicht  (Spot)   Punktlicht (Point) 
Pkt. sichtbar/unsichtbar       Pkt. sichtbar/unsichtbar  Pkt. sichtbar/unsichtbar 
 
Tip:  
Drücken Sie die ‘X’, ‘Y’ oder ‘Z’ Taste beim ziehen von Kontrollpunkten um die entsprechenden Achsen zu sperren. 
 
Lichtquellen können wie jedes andere Objekt mit den Transformations Werkzeugen verschoben, gedreht, gespiegelt oder 
kopiert werden. 
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Mit dem Skalieren Werkzeug können Lichtquellen auch relativ zu einem anderen Punkt verschoben werden. Dies verändert 
keine Einstellungen sondern nur die Position  Skalieren ist ein einfache Möglichkeit Lichtquellen zu einem oder von einem 
Punkt zu verschieben. 
 
 
 
Licht Einstellungen 
Einstellungen für Lichtquellen können vorgenommen werden indem Sie die Lichtquelle wählen und anschliessend im Objekte 
Bearbeiten Fenster die Werte ändern.  
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Licht Intensität und Dämpfung 
Die Voreinstellung für die Intensität ist 0.75. Eine höhere Intensität als 1 bewirkt einen „brenn“ Effekt im Bild. Wenn die 
kombinierte Intensität von mehreren gleichgerichteten Lichtern grösser als 1 beträgt kann das Bild überbeleuchtet wirken. 
 
Es gibt Lichtquellen mit und ohne Dämpfung. Die Voreinstellung ist ohne Dämpfung. Lichtquellen mit Dämpfung sind 
realistischer da diese über eine Distanz an Intensität verlieren. Allerdings sind sie schwieriger zu kontrollieren da die Intensität  
beim schieben der Lichtquelle neu angepasst werden muss. 
Eine Lichtquelle mit Dämpfung benötigt in der Regel viel mehr Intensität um eine ähnliche Helligkeit wie eine Lichtqeuell 
ohne Dämpfung zu erreichen. 
 
Farbe der Lichtquellen 
Die Farbe der Lichtquellen kann über das Objekt Bearbeiten Fenster geändert werden (>Bearbeiten >Objekte bearbeiten 
Attribute >Farbe). Wenn einer Lichtquelle eine dunkle Farbe zugewiesen wurde wird es eher schwierig das Modell in der 
Objektfarbe des Modells zu rendern, besonders wenn die Objektfarbe blass ist. 
 
Schattenwurf 
Für den Schattenwurf gibt es fünf Einstellungen … 
 

 
 
Aus  Die Option Schatten werfen ist nicht gewählt 
 
Hard  Schatten haben abrupte Kantenübergänge 
 
Medium Schatten haben etwas weichere Kantenübergänge 
 
Soft  Schatten haben weiche Kantenübergänge 
 
Blurry  Schatten haben sehr weiche Kantenübergänge 
 
Tip: 
Weiche Schatten sehen realistischer aus wenn die Lichtquelle nahe beim Objekt steht. 
 
Schatten spielen bei photorealistischen Renderings eine sehr wichtige Rolle. Sie helfen uns die Modelle im Raum zu 
lokalisieren, zeigen welche Texturen appliziert wurden und bestimmen die Modellform. Beim positionieren der Lichtquellen 
muss der Schattenwurf beachtet werden damit ein ansprechendes Bild resultiert. Zu viele, schlechte und unvereinbare 
Schattenarten können unrealistische oder irritierende Renderings erzeugen. 
 
Im Allgemeinen sollte die Option Schatten werfen für alle Lichtquellen immer eingeschaltet sein die das Modell beleuchten. 
Andernfalls kann das Rendering unrealistisch erscheinen. Für ansprechende Renderings sollte der Schattenwurf in der Regel 
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bei allen Lichtquellen der gleiche sein. Oft ist man aber aus Gründen der Einfachheit gezwungen bei einigen Lichtquellen die 
Schatten auszuschalten. 
 
Volumetrische Schatten 
Im Objekt Bearbeiten Fenster gibt es für Lichtquellen die Option Volumetrische Schatten werfen. Wenn Sie ein 
Vordergrund Effekt (Foreground) wie z.B. Verstreuung (Light Scattering) gewählt haben können Sie bestimmen ob das Licht 
mit dem Fordergrund interagiert  

 
        A            B    C 
 

A Volumetrische Schatten nicht gewählt  -  Vordergrund Verstreuung mittel nicht sichtbar. 
B Volumetrische Schatten gewählt  -  Vordergrund >Verstreuung mittel >Gleichmässig 
C Volumetrische Schatten gewählt  -  Vordergrund >Verstreuung mittel >Turbulent 
 
Im obigen Bild beleuchtet eine einzige abgeschwächte Spotlichtquelle die Szene welches als Vordergrund >Verstreuung Mittel 
(Scattering Medium) eingestellt hat. Dadurch wird eine rauchige und neblige Umgebung simuliert. 
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Rendern der Szene 
Nachdem Sie Ihr Modell erstellt haben, die Lichtquellen und den Hintergrund bestimmt sind, können Sie das Rendering 
erstellen. Im Menü Rendern finden Sie verschiedene Befehle welche absteigend bessere Qualität ergeben. 
 

 
 
Für eine schnelle Vorschau verwenden Sie die qualitativ schlechteren Befehle. 
Für das endgültige Rendering sollten Sie aber den Befehl >In Datei Rendern… verwenden und im eingeblendeten Fenster den 
Rendermodus >Raytrace (Schatten an, Anti-Alias) verwenden. 
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Die Werte in den Feldern Breite und Höhe bestimmen die Grösse des Rendering in Pixel. Abhängig von der Grösse und der 
Qualität des endgültigen Renderings muss der Wert angepasst werden. Je höher der Wert ist desto länger dauert die Renderzeit. 
Beginnen Sie mit einem Wert von 1000 für die Breite und prüfen Sie anschliessend die Qualität am Bildschirm und beim 
drucken. 
In der Regel muss man mehrmals ein Vorschau machen und Änderungen an der Szene vornehmen, bis man das endgültige 
Resultat hat wie man es sich vorstellt. Dies ist in der Tat ein Versuchs- und Fehlerfindungsprozess. Ein Trost ist, dass Sie das 
Endresultat speichern und danach auch für andere  Modelle verwenden können. 
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Vorgegebene Schattiertypen 
Color 

 

>Fenster >Objekte bearbeiten >Material >Fortgeschritten >Schattieren >Color 
 

 

 
 
Anmerkung: Die Information in Klammer gibt den Faktor beim Erstellen des Bildes an. 
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Fortsetzung 
 

 
 
Anmerkung: Die Information in Klammer gibt den Faktor beim Erstellen des Bildes an. 
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Displacement 

 

>Fenster >Objekte bearbeiten >Material >Fortgeschritten >Schattieren >Displacement 
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Transparency 

 

>Fenster >Objekte bearbeiten >Material >Fortgeschritten >Schattieren > Transparency 
 

 

 
 
Anmerkung: Die Information in Klammer gibt den Faktor beim Erstellen des Bildes an. 
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Reflectance 

 

>Fenster >Objekte bearbeiten >Material >Fortgeschritten >Schattieren >Relectance 

 

 
 
Anmerkungen: 

• Die Information in Klammer gibt den Faktor beim Erstellen des Bildes an. 
• Materialien welche Schatten aufnehmen (shadow catcher) sollten nur für Hintergründe eingesetzt werden. 
• Für Translucency und Translucent Plastic muss sich eine Lichtquelle innerhalb des Modell befinden damit dieses 

richtig dargestellt wird. 
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Fragen und Antworten 
F Why aren’t Infinite Studio Background shadows rendering properly? 
A A property of the Shadow Catcher texture may have been altered, either re-apply the texture or replace the studio file 

with a new import. 
• Blurry Shadows will sometimes create interference patterns on a Shadow Catcher surface 
• Transparency Shadows rendering does not support Soft/Medium/Blurry Shadows this setting must be Un-
Checked in PhotoRender>Advanced Settings… >Use Transparency Shadows 
 

F Why are the Soft/Medium/Blurry Shadows weak or unrealistic? 
A The light may be too far from the object 

• The object may have Cast Shadows >Un-checked 
• The object may have Receive Shadows >Un-checked 
• The Light may have Cast Shadows >Un-Checked 
• The Ambient light setting may be too high 
• Transparency Shadows rendering does not support Soft/Medium/Blurry Shadows this setting must be Un-
Checked in PhotoRender>Advanced Settings…>Use Transparency Shadows 
 

F Why does the Backdrop appear ‘banded’ or ‘checked’? 
A Universal and Chrome Studio Backdrops should have Is Backdrop Object >Checked in the Edit Object 

Window. Infinite Studios should have Is Backdrop Object>Un-Checked 
 
F Why won’t the light illuminate the scene? 
A Enable Light must be Checked in the Edit Object Window 

• If the light is attenuated it may need a very high intensity value 
 

F Why are the object colors grey or dull in the rendering? 
A Some materials properties may be set too low, particularly Reflectance>Diffuse 

• There may be insufficient light on directed towards the object 
• Colored lights may have distorted the object color 
 

F Why are there different sized backdrops visible? 
A More than one Studio type or size may be visible, check the layer manager 
 
F Why is there a ball visible in my model? 
A A Test Ball may be visible, check the layer manager and make Test ball layer invisible 
 
F Why is the scene over bright? 
A More than one Studio type or size may be visible, check the layer manager 

• Too many lights may have been added or a light has been duplicated in the same position as another light 
• Ambient Light may be set too high 
 

F Why can’t I see my model in Shaded View Mode? 
A Some video hardware or software may not repaint the screen correctly in perspective mode. Turn off perspective or 

shading 
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F Why doesn’t my model look shiny? 
A The wrong Studio Type may have been chosen for reflective objects 

• The Background (not Backdrop) color may not have enough contrast against the Backdrop, try resetting the color 
through Photo- Render> Edit Background… 

 
 
 
 
 
 
Anmerkungen und Ergänzungen zu diesem Handbuch senden Sie bitte an: 
info@arnold-cad.com 
 
 
 
 


	Kurzeinführung
	Die Rendering Umgebungen
	Universal Studio
	Chrome Studio
	Infinite Studio

	Modell für das Rendering vorbereiten
	Objekt Auflösung einstellen
	Farben zuweisen
	Materialien zuweisen
	Materialien bearbeiten
	Fortgeschrittene Render Material Einstellungen
	Die fünf Schattierarten
	Anwenden der Schattierart (Shader Typ)

	Abbilder
	Anbringen von Abbildern (Wrapped Image)
	Texturen ausrichten (Texture Space)
	Reflektion bestimmen
	Benutzerdefinierter Abbilder

	Studio Umgebungen
	Studio Typ für das Rendering wählen
	Importieren des Studios
	Studio Layer Komponenten
	Universal Studios: mini, small, medium und big
	Universal Studio: mega
	Chrome Studio: Alle Grössen
	Infinite Studio: mini & small
	Infinite Studio: medium
	Infinite Studio: big & mega
	Wahl der Studio Grösse

	Rendering erstellen
	Positionierung des Modells
	Ansicht bestimmen
	Kamera Ansichten
	Ansichtausschnitt
	Speichern der Ansicht
	Hintergrund ausrichten
	Farben und Texturen der Umgebung
	Licht und Beleuchtung
	Beleuchtungsart
	Licht Typ
	Positionieren und schieben der Lichtquellen
	Licht Einstellungen
	Licht Intensität und Dämpfung
	Farbe der Lichtquellen
	Schattenwurf
	Volumetrische Schatten
	Rendern der Szene

	Vorgegebene Schattiertypen
	Color
	Displacement
	Transparency
	Reflectance

	Fragen und Antworten

